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MAT.:Solicita reconocimiento como
“Humedal urbano” al humedal
Carcamo

CONCEPCION, 16 Nov, 201

DE: ALCALDE DE CONCEPCION.

A: MINISTRA DE MEDIO AMBIENTE
Sefiora CAROLINA SCHMIDT ZALDIVAR.

Junto con saludarla, adjunto enviamos expediente del Humedal Carcamo de la
comuna de Concepcién, solicitando su reconocimiento como humedal urbano, de

acuerdo a lo establecido en la Ley N° 21.202 del afio 2020.

Saluda atentamente a usted,

vB/KRC/ aavb.-

‘Distribucién:

- Sefiora Carolina Schmidt Zaldivar, Ministra de Medio Ambiente (oficinadepartes@mma.gob.cl;
oficinadepartesbiobio@mma.gob.cl)

- Archivo Alcaldia

- Archivo DMA.

- Archivo Asesoria Urbana
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L Identificacién y contacto del o los municipios solicitantes, e
informacién de contacto del funcionario encargado del proceso
Yy su subrogante.

1. Nombre del o los municipios que presentan la solicitud:
llustre Municipalidad de Concepcién
Alcalde: Alvaro Ortiz Vera
2. Contacto del o los municipios que presentan la solicitud (correo electrénico):
Direccion: OHiggins N2 525, Concepcidn.
Fono: 41 - 2266500; 41 - 2263041
Email: alcaldia@concepcion.cl
3. Nombre y correo electrénico de él/la encargado/a del proceso de solicitud:

Andrea Aste Von Bennewitz, directora de Medio Ambiente de la Municipalidad de Concepcidn.
Email: andrea.aste@concepcion.cl

4. Nombre y correo electrénico él/la subrogante encargado/a del proceso:

Karin Rudiger Canaan, asesor urbanista de la Municipalidad de Concepcién.
Email: krudiger@concepcion.cl
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I. Antecedentes generales del humedal y su localizacion.

1. Nombre o denominacién del humedal:
Humedal Estero Carcamo.
2. Divisién politico-administrativa a nivel regional, provincial y comunal:

El Humedal Estero Carcamo, se localiza dentro de los limites urbanos vigentes del plan regulador
comunal de la comuna de Concepcidn, provincia de Concepcién, region del Biobio.

3, Superficie total en hectareas que comprende el drea que se solicita sea reconocida
como humedal urbano.

Coordenada Coordenada
Central X Central Y

65,932506 20874.8011 | 675,617.147955 5920394.673145
Datum WGS 84 / Huso 18 Sur.

Superficie Ha | Perimetro Mt

4. Representacion cartografica digital del area objeto de la solicitud, que contenga la
descripcion del (los) poligono(s) que se solicita(n) reconocer como humedal urbano vy las
respectivas coordenadas geograficas por cada punto que las delimitan; asi como el limite
urbano de la comuna donde se localice el humedal.

Debido a la extension y el patrén de distribucion que presenta el humedal estero Carcamo, se
desarrollaron dos series cartograficas para su representacion. La primera titulada “DELIMITACION
DEL HUMEDAL ESTERO CARCAMO1” cumple con la representacion requerida, sin embargo, los
3.392 vértices que lo delimitan no son factibles de identificar en un plano de estas dimensiones.
Para subsanar esta limitacion se anexan 5 cartografias complementarias en formato AO (841 x
1189 mm) tituladas “IDENTIFICACION DE VERTICES DELIMITANTES DEL HUMEDAL ESTERO
CARCAMO2” las cuales deben ser leidas en complemento a la lista “Vértices Humedal Estero
Carcamo.xlsx3”.

1 Anexo Digital: Humedal_Estero_Carcamu\Cartografias\Ol_Delimitacion__Humedalm_Estero_Carcamo.tif
2 Anexo Digital: HumedaI_Esteru_Carcamo\Cartografias\OZ,ldentiﬁcac'lon de Vertices

3 Anexo Digital: Humedal_Estero_Carcamo\Vertices Humedal Estero Carcamo.xlsx
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DELIMITACION DEL HUMEDAL ESTERO CARCAMO )
COMUNA Y PROVINCIA DE CONCEPCION, REGION DEL BlOBIiO

Simbologia Cartografica Informacion Cartografica
i imi Fuente Cartografica:
Humedal Estero Carcamo e | jmite Comunal PRC Modelacion en base a DEM del PRMC 2013
- Cauce Principal del Carcamo ===~ Limite Urbano PRC Limites en base a cartografia PRC Concepcion
Red Hidrica Carcamo Parque Metropolitano Cerro Caracol Datum: WGS-84
Huso: 18 Sur

Cuenca del Carcamo [T Reserva Nacional Nonguen Escala Grafica: 1:12.000

Figura 1. Delimitacién del humedal Estero Carcamo, comuna de Concepcion, region del Biobio.
Fuente: Elaboracidn propia.
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. Metodologia de delimitacion.

La metodologia de delimitacién empleada para el Humedal Estero Cdrcamo, combino técnicas de
delimitacién de cuencas hidrograficas, estimacion de indices espectrales y rectificacion de
informacion en terreno. La figura N°1 sintetiza la metodologia empleada. A continuacién, se ofrece
un detalle ampliado sobre los procesos:

Red hidrolégica
----- del estero carcamo

Delimitacion de Anélisis de superficie
cuenca  j-------- > mediante Modelo [------ ‘
Hidrografica digital de elevacién ! Cuenca
femeen hidrolégica y su
boundering Box
- NDVI —
Lp{  EVI
Delimitacién de | Delimitacién de zonas
Humedal en —i.p| NDVI | | [Clasificacién| vegetacionales y
base a indices : Supervisada| hamedas
espectrales : representativas
L_ > Infrarrojo
. [vegetacién | |
~ P Vigorosa
Delimitacién superficial
P mediante GPS [T
Rectificacién de 5

delimitaciéon en
terreno

Rectificacion aérea con
=P vuelo dron

O Objetivo Método l | Producto

Figura 2. Sintesis del proceso metodoldgico.
Fuente: Elaboracién propia.
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1. Delimitacion de cuenca hidrogrdfica:

El humedal Estero Carcamo se distribuye como una red de quebradas que confluyen en un cauce
comun, conocido como “Estero Carcamo” o “humedal madre”, esta caracteristica particular
planted el desafio de establecer una delimitacion del drea de influencia hidrolégica o cuenca
hidrogréfica, para asi poder estimar una representacién de la red de drenaje que conforma el
humedal, asi como generar un drea de delimitacion o boundering box que permitiese poder
ajustar las imagenes satelitales utilizadas en los procesos posteriores. Para su estimacion se utilizé
el modelo digital de elevacion del plan regulador metropolitano de concepcién de 2013 con una
resolucidn espectral de 5 x 5 m.

El proceso de delimitacidn se efectud utilizando la extension Spatial Analyst de ArcMap 10.8. La
secuencia de pasos fue la siguiente:

Dem - ArcToolbox > Spatial Analyst Tools > Hydrology > Fill

ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Direction
ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Accumulation
ArcToolbox > Spatial Analyst > Conditional > Con

ArcToolbox > Spatial Analyst Tools > Hydrology > Stream to Feature
ArcToolbox > 3D Analyst Tools > Functional Surface > Interpolate Shape
ArcToolbox > Spatial Analyst Tools > Hydrology > Watershed
ArcToolbox > Conversion Tools > From Raster > Raster to Polygon

D@ o o0 T

El respaldo de los archivos generados en este proceso puede ser revisado en el Anexo Digital:
Humedal_Estero_Carcamo\ \BBDD\Delimitacion de Cuenca.
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2. Delimitacion de humedal en base a indices espectrales:

La extensién y disposicién natural del humedal Estero Cdrcamo imposibilita un transito continuo
sobre este, por esta razén fue pertinente apoyar la delimitacién con el uso de imagenes satelitales
que permitan discriminar la distribucion de vegetacion propia del ambiente himedo.

Para efectuar este proceso se utilizé una imagen S2MSI2A del satélite Sentinel-2, plataforma 2SA
con fecha de captura 17 de Julio de 2021. Las propiedades espectrales del producto se resumen en
la Figura 3.

Banda ¢ Resoluciéon < o e % Descripcién $
central

B1 60 m 443 nm Ultra azul (Costa y Aerosol)

B2 10m 490 nm Azul

B3 10m 560 nm Verde

B4 10m 665 nm rojo

BS 20m 705 nm Visible e Infrarrojo Cercano (VNIR)

B6 20m 740 nm Visible e Infrarrojo Cercano (VNIR)

B7 20m 783 nm Visible e Infrarrojo Cercano (VNIR)

B8 10m 842 nm Visible e Infrarrojo Cercaneo (VNIR)

B8a 20m 865 nm Visible e Infrarrojo Cercano (VNIR)

B9 60 m 940 nm Onda Corta Infrarroja (SWIR)

B10 60 m 1375 nm Onda Corta Infrarroja (SWIR)

B11 20m 1610 nm Onda Corta Infrarrcja (SWIR)

B12 20 m 2190 nm Onda Corta Infrarroja (SWIR)

Figura 3. Comportamiento de las diferentes bandas que conforman las imagenes Sentinel 2.
Fuente: Elaboracidn propia.

La Tabla 1 sintetiza las operaciones efectuadas con las diferentes bandas de la imagen utilizada, a
continuacion, se ofrece una descripcién para cada indice:

indices estimados Combinacién de bandas utilizadas
Infrarrojo 8-4-3
Vegetacion Vigorosa 8a-11-2
fndice de vegetacién de diferencia normalizada. | (8—4)/(8 +4)
Indice diferencial de agua normalizado (3-11)/(3+11)
Indice de vegetacién mejorado G*((B8A-B04)/((B8A+C1*B04-C2*B02)+L))

Tabla 1. Sintesis de calculos efectuados sobre imagen Sentinel 2.
Fuente: Elaboracion propia.

Descripcién de los indices estimados

I Infrarrojo: Esta combinacién de bandas tiene buena sensibilidad a la vegetacion verde (la
cual aparecera representada en una tonalidad roja), debido a la alta reflectividad en el
infrarrojo y la baja en el visible, y representa de forma clara caminos y masas de agua.
Ademds, muestra bosques coniferos con un rojo mas oscuro mientras que los bosques
caducifolios lo hacen con un rojo mas claro.

Il.  Vegetacién vigorosa: Utilizada para la deteccion de vegetacién en un estado saludable,
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diferenciado vegetacién nativa y plantaciones de monocultivo forestal.

ll.  indice de Vegetacion de Diferencia Normalizada (NDVI): Es un indice de vegetacion que
se utiliza para estimar la cantidad, calidad y desarrollo de la vegetacién con base a la
medicion de la intensidad de la radiacién de ciertas bandas del espectro electromagnético
que la vegetacidn emite o refleja.

15104
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IV.  indice Diferencial de Agua Normalizado (NDWI): Se utiliza como una medida de la
cantidad de agua que posee la vegetacién o el nivel de saturacién de humedad que posee
el suelo.

V. indice de Vegetacién Mejorado (EVI): Provee informacién que permite monitorear el
estado de la vegetacidn en caso de altas densidades de biomasa.

Posteriormente se efectuaron rutinas de clasificacién supervisada para poder estimar las dreas de
vegetacion diferenciada. El modelo fue entrenado diferenciando principalmente 3 areas de interés
o “clisteres”:

a) Vegetacidn hidrofita: Representada principalmente por los remantes de vegetacidn nativa
dispuestos entornos a las quebradas y el curso principal del humedal estero carcamo.
b) Vegetacion Monocultivo: Representado por extensos parches de pino y eucaliptus

dispuestos entre las quebradas y los caminos del fundo la cantera y el guindo. Conforman el
elemento principal de la cuenca del cdrcamo v los cerros colindantes.

c) Suelo desnudo y suelo urbanizado: Representado por caminos de arcilla expuesta y
compactada, segln la vialidad propuesta por el PRMC se trata de las las proyecciones de los
caminos espafioles oriente y poniente, avenida inglesa, caracol poniente y camino Einstein entre
otros.

Los resultados de estos procesos se superpusieron para posteriormente ser ajustados mediante
inspeccidn visual y rectificacién en terreno. El respaldo de los archivos generados en este proceso
puede ser revisado en el Anexo Digital: Humedal_Estero_Carcamo\BBDD\Raster.

1. Rectificacion de delimitacion en terreno:
Con el objetivo de rectificar los resultados obtenidos mediante técnicas de teledeteccion y
sensoramiento remoto se efectuaron 8 jornadas de rectificacién en terreno apoyados con
dispositivos GPS. Adicionalmente se efectuaron vuelos fotogramétricos con dron DJI Mavic 2 Pro.
Debido a las caracteristicas fisicas e hidrolégicas del terreno, no fue posible acceder a todas las
quebradas, por lo que el andlisis en conjunto de la metodologia propuesta es clave para la
delimitacién del Humedal

Se elaboro un Web Map Bajo la plataforma ArcGis Online el cual contiene enlaces adjuntos a
imagenes y videos que muestran en detalle la conformacion de algunos sectores representativos
del humedal estero carcamo.

El acceso es mediante el siguiente enlace: https://arcg.is/1jTH8uO.
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Para consultar la informacién adjunta se debe seleccionar cualquiera de los puntos que conformar

“\/ideos_Imagenes”. A continuacion, se desplegarad una ventana emergente que contiene el
ulo se abrira una

la capa
enlace de la foto o video segin corresponda. Al hacer clic sobre el hipervinc

pestafia sobre el navegador web que permitird consultar el enlace.

ArcGIS v Guia de imagenes y videos - Delimitacion Humeda! Estero Carcamo #  Abriren el nueve Map Viewer  Nueve mapa

& Guardar ~ @0 Compartic & Imprimir v | &3 mecir [l Marcacores | Buscar

[[]Detalles + Agregar ~ | .* Sdfitar i Mapa base |

® B E
Contenido

Videos Imagenes
Red Carcamo

mecal Carcamo

Delimit

Cuenca C

b (D imagery - L

Trart AreGIS Aviat fage! Cenzacts & Ean

CImuriedr azaT

Figura 4. Vista del mapa web “Guia de imagenes y videos — Delimitacién humedal estero Carcamo”
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V. Informacién complementaria del humedal estero Carcamo.

Clima: Clima templado, mediterrianeo con lluvias invernales, 11 meses libres de heladas,
temperatura media anual es de 12,1°C, una maxima anual de 19,1°C Yy una minina de 2°C, con una
pluviometria anual de 1110 mm (Santibafiez & Uribe, 1992).
Topografia: El drea de estudio contempla variadas exposiciones, presentando un rango de
pendiente que va desde 5-80%, con un promedio de 27%. Ademas, alcanza una altitud minima de
3 msnm, y una méxima de 250 msnm (Carrasco et al., 1993)

Suelo: Origen granitico, con textura arcillosa, capacidad de campo alrededor de 14%, punto de
marchites permanente alrededor de 7.9%, densidad de 1,47 gr/cm3, baja infiltracién, alta
plasticidad y adhesivos en himedo, estructura en bloques, duros y compactos en seco (Carrasco
et. at., 1993). La mayor desventaja es la pendiente, junto a los datos anteriormente sefialados lo
hacen mas susceptibles a la erosién, encontrandose en algunas zonas la presencia de cércavas.

Hidrografia: La cuenca hidrografica del estero Carcamo abarca un drea total de 180,76 ha y un
perimetro de 8.032,2 m. Esta se localiza integramente al interior del “fundo la cantera y el
guindo”, propiedad de la corporacién Universidad de Concepcidn, la cual representa al menos el
70,5% de los terrenos de estos fundos (Figura 5).

gt e

o la Cante

Figura 5. Delimitacién de la cuenca hidrica del humedal — estero Cércamo.
Fuente: Modelacién propia.

La red hidrica de la cuenca esta conformada por un curso principal reconocido como “Humedal -
estero Cdrcamo”, el cual se extiende por 3,13 km y sobre el cual drenan 14 quebradas principales
(Figura 5). Su origen se localiza en una de las cotas de maxima altura (235 a 255 msnm), desde
donde el agua fluye en direccién norte hasta el tranque de agua localizado en la parte superior al
sector conocido como “Calama”. Parte del flujo excedente drena hacia una cascada ubicada en la
Universidad de Concepcién (UdeC) conocida como “cascada UdeC” (Figura 6).

11
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<14 quebradas drenan
&l curso principal

#Longitud de cauce principa

Origen

Figura 6. Red hidrica e identificacion de quebradas del humedal — estero Carcamo.
Fuente: Modelacion propia.

Figura 7. Hitos sobre el estero humedal - estero Carcamo (Coordenadas en sistema UTM, Datum WGS 84 -
18 Sur. a. Vista hacia la cota de origen del Carcamo (675523.17 E; 5919377.33 S) b. Tranque de agua sobre
sector Calama (675817.43 E; 5921475.35 S) c. Cascada UdeC (675764.21 E; 5921574.83 S). Fuente:
Elaboracion propia.
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Caracterizacion Biética del Humedal-Estero Carcamo: La zona central del pais, y en especial la
zona costera, se encuentra catalogada como parte de uno de los veinticinco hot-spots mundiales,
es decir, dreas que albergan la mayor concentracién de especies endémicas del mundo, ademas,
de ser reconocida como un drea de transicion ecolégica de alta riqueza (Soto et al., 2010).

En términos vegetacionales, el humedal-Estero Carcamo, se inserta dentro de la regién del bosque
Caducifolio, la cual se caracteriza por poseer un clima de tipo mediterraneo, y la dominancia de
especies deciduas de hoja grande del género Nothofagus. Esta regidn se encuentra representada
por la sub-regién del Bosque Caducifolio del Llano, que comprende el territorio de la Cordillera de
la Costa y de la Depresion Intermedia, cubierto por bosques de zonas de baja altitud (Gajardo,
1994).

Dentro de esta Sub-region es posible distinguir la Formacién del Bosque Caducifolio de Concepcion,
distinguiendo su méxima representacién en el Parque Nacional Nonguén, donde abarca 2.135 ha
de las 3.036,9 ha totales. Sin embargo, es posible encontrar fragmentos de este tipo de bosque en
los cerros aledafios, como Cerro Caracol, Cerro Manquimavida, Parque Metropolitano Cerro
Caracol, Cerros de Hualqui y Chiguayante, y en general en todo el Territorio Nonguén, formando
naturalmente un corredor bioldgico que interconecta estos fragmentos (Fig. 3), ademds, aun
cuando se dice que la fragmentacidén de bosques puede afectar las condiciones abidticas de los
fragmentos, la composicion y la abundancia de las especies asociadas a ellos, o afectar
indirectamente interacciones bioldgicas, los fragmentos de vegetacién natural, incluso cuando
estan degradados son fuentes valiosas de biodiversidad local en los planes de restauracién (Gaete,
2016)

~
“~, Corredor Biologico Del Parque Nacional Nonguén
; 2« Altamente Fragmentado

0]
A
i
|
|
L)
)
\
\
\

Figura 8. Representacidn del Corredor Bioldgico entre Parque Nacional Nonguén y cerros
aledafios.

En términos generales, esta zona presenta un alto cardcter de transicién vegetacional donde
convergen representantes del Bosque Esclerdfilo; como Peumus boldos, Cryptocarya alba, Lithraea
caustica, y Quillaja saponaria, con representantes del Bosque Laurifolio; como Luma apiculata,
Gevuina avellana, Amomyrtus luma, Ugni molinae y Chusquea quila, ademds de presentar
caracteres vegetacionales propios, como lo son los bosques de Nothofagus obliqua y N. dombeyi.

En cuanto a los fundos La Cantera y El Guindo, lugar donde se emplaza el Humedal Estero
Carcamo, la composicidn vegetacional varia en relacidn con las caracteristicas fisicas del lugar, el
cual se caracteriza por presentar quebradas abruptas de cotas maximas de alrededor de 255
msnm y cotas minimas que alcanzan los 114 msnm, generando diferencias de hidrolégicas entre el
cuerpo principal de agua y los catorce cuerpos de agua secundarios que drenan hacia el primero,
lo que se traduce en diferencias en la disponibilidad de agua (la cual es mayor en temporada

13
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invernal) y por consiguiente en la estrata arbdrea presente. Esta informacion se detallara en los
puntos que siguen.

A continuacién, se detallan tres de los cinco reinos taxondmicos que mejor caracterizan y
representan al humedal estero Carcamo, los cuales se complementaron con catastros de especies,
detallando su origen y estado de conservacién, parametros necesarios para analizar el porcentaje
de endemismo de la zona y sus niveles de amenaza.

I.  Reino Vegetal (flora)

La composicién vegetal del fundo La Cantera y El Guindo se encuentra constituida; de un total de
283,81 ha que comprende el fundo, por 53,6 ha de bosque nativo fragmentando (Gaete, 2016)
rodeado por una matriz compuesta por plantaciones de Eucalyptus globulus y Pinus radiata.
Algunas de las especies caracteristicas del Humedal son; Aextoxicon punctatum, Aristotelia
chilensis, Chusquea quila, Cryptocarya alba, Gevuina avellana, Lapajera rosea, Laurelia
sempervirens, Nothofagus obliqua, Peumus boldus, Persea lingue, entre otras.

Debido a las caracteristicas hidrolégicas y fisicas del Humedal, es posible encontrar zonas riparias
con bosques de vegetacion hidrdfila conformado por asociaciones de Luma chequen, Myrceugenia
exsucca, M. parvifolia, Blepharocalyx cruckshanksii y Drimys winterir var. winteri, las cuales se
concentran en las periferias del cuerpo principal de agua y de los cuerpos de agua secundarios que
drenan hacia este ultimo, ademas en zonas donde el cuerpo de agua es permanente, es posible
encontrar representantes de la familia Cyperaceae, con especies como: Carex excelsa, C. acutata,
C. chilensis, C. aphyla, C. multispicata, Cyperus eragrostis, Isolepis nigricans y Eleocharis sp. (Baeza,
Marticorena & Rodriguez, 1997). Asi mismo, es posible encontrar plantas no vasculares asociadas
a ambientes himedos y sombrios; caracteristicas que se encuentran facilmente en las quebradas,
con representantes tanto de Bryophytas sensu stricto, como de Pteridophytas destacando
Blechnum chilense quien se distribuye ampliamente por las quebradas. :

En cuanto a la composicién de especies encontradas a lo largo del Humedal Estero Carcamo,
hemos determinado 170 especies, de las cuales 22 son introducidas, 94 nativas y 54 endémicas.
De ellas 7 especies se encuentran categorizadas bajo amenaza segln la Unién Internacional para la
Conservacién de la Naturaleza y el Reglamento de Clasificacién de Especies Silvestres del
Ministerio del Medio Ambiente. De estas Ultimas, solo detectamos una planta no vascular,
Asplenium trilobum la cual debido a sus necesidades ecoldgicas requiere de zonas humedas para
su sobrevivencia, Berberis negeriana presenta un rango de distribucion exclusivo para la octava
regién y en particular para Concepcién, siendo su presencia catalogada como RARA, Calydorea
xiphioides presenta un escueto rango de distribucién, Citronella mucronata presenta una
disminucién poblacional sostenida en las Gltimas tres décadas, Greigia sphacelata ha disminuido
su poblacién debido a la destruccién de su habitat, al igual que Myrceugenia parvifolia, y Pitavia
punctata se encuentra declarada desde 1995 como Monumento Natural, por lo que su tala se
encuentra prohibida.

En el ANEXO 1., se adjunta el catastro de flora del humedal estero Carcamo, el cual se generd
mediante recopilacién bibliografica de estudios realizados en la zona y en el fundo La Cantera y el
Guindo, ademas la revisién fue complementada con identificacion de especies en terreno.

Il.  Reino Fungi (hongos)

El reino de los hongos es sin duda uno de los més reciente, taxonomicamente hablando, pues por
mucho tiempo se consideraron plantas, y por lo general se asocian a muerte y pudricién, no
obstante, estos juegan un papel clave en el ecosistema, siendo capaces de conectar la vida a
través de una compleja red, generando ectomicorrizas, las cuales recubren las raices de los arboles
incrementando su capacidad de absorcion, tanto de agua como de nutrientes, reduciendo las
concentraciones de CO, de la atmosfera y almacenandolo en el suelo. Asi mismo, algunos
requieren condiciones abidticas especificas para su fructificacion, como humedad constante y
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temperaturas templadas, caracteristicas que son posibles de encontrar en el Humedal Estero
Carcamo.

En este ultimo, hemos registrado 114 especies de hongos, los cuales se distribuyen (generalmente)
en asociacion al bosque nativo presente en el humedal. Del total, registramos 53 especies
introducidas, presumiblemente producto de la introduccién de especies exdticas como Pinus sp.,
40 nativas, 13 endémicas, y 8 que no presentan informacién con relacién a su origen. De ellas, solo
6 se encuentran evaluadas bajo amenaza segun el Registro de Especies Silvestres Protegidas (RCE)
y el organismo internacional UICN.

En general, su categoria de conservacion se asocia directamente a la perdida habitat, en particular
a especies del género Nothofagus, con quienes forman asociaciones micorricicas que permiten su
sobrevivencia, como es el caso de Gastroboletus valdivianus, y otros, como Boletus loyita, B. loyo,
Cortinarius lebre han visto diezmada su poblacidon debido a la colecta desmedida para el consumo
y la venta. Otro caso particular es el del ascomicete endémico Nothojafnea thaxteri, quien se
encuentra evaluado como Vulnerable por la UICN, y fue descrito por primera vez en Concepcién,
siendo el Humedal-Estero Cdrcamo uno de los lugares que alberga esta poblacién, la cual se
considera posiblemente extinta.

En paralelo también es posible encontrar hongos que brindan servicios alimenticios y econdmicos
para las comunidades aledafias como: Lactarius quieticolor, Ramaria flava y Suillus luteus, quienes
forman parte fundamental de la dieta invernal de los pobladores de la poblacién Agiita de la
Perdiz y Barrio Universitario, ademads de otorgar beneficios econdmicos debido a la colecta y venta
de estos organismos.

En el ANEXO 2, se adjunta el catastro de especies de hongos el cual se generd mediante revision
de recopilacién bibliografica de estudios realizados en el drea en el fundo La Cantera y el Guindo, y
se complementd con identificacién en terreno.

lll.  Reino animal (fauna)

El humedal estero Carcamo alberga una amplia variedad de especies animales, compuesta de
aves, mamiferos e invertebrados, todos capaces de sostener cadenas tréficas complejas hasta la
actualidad.

De acuerdo a recopilacién bibliogréfica y la identificacion de especies en terreno, se han registrado
187 especies animales, de los cuales 104 son artrépodos, 83 cordados y 1 molusco. En cuanto a su
origen, para este reino se considerd el parametro cosmopolita, obteniendo como resultado un
total de 5 introducidos, 1 cosmopolita, 126 nativos, 41 endémicos y 14 sin informacion.

De las 53 especies de Aves, 5 se encuentran evaluadas bajo amenaza en su estado de conservacién
segun la UICN: Accipiter bicolor, Campephilus magellanicus, Strix rufipes, Columba araucana y
Enicognathus leptorhynchus. En cuanto a los mamiferos, 5 de estos se encuentran amenazados,
Galictis cuja, Pseusalopex griseus, Pudu pudu y Oncifelis guigna, siendo este ultimo quien
presentan mayor amenaza, pues se encuentra categorizado como En Peligro por la UICN, debido a
gue se estima que su poblacién se ha reducido a tal punto, que hoy en dia es posible encontrar
menos de 500 individuos de la poblacidn.

Quien representa de mejor manera el nivel de endemismo de este humedal es Aegla
concepcionensis, una especie de crustaceo endémica de Concepcidn. Posee dos poblaciones en el
Cerro Caracol, una de ellas se localiza en el humedal estero Carcamo, lo cual refleja la calidad de
las aguas, puesto que, al ser un organismo filtrador, requiere de aguas ricas en oxigeno para
mantener su delicada existencia. Esta especie fue declarada extinta hasta su redescubrimiento el
ano 2004, y actualmente hemos registrado su presencia en al menos 7 de los 14 cursos de agua
que drenan al curso principal del Humedal-Estero Carcamo, lo que refleja aiin mas la prioridad de
conservar y proteger este

En el ANEXO 3, se adjunta el catastro de fauna, el cual se generé mediante revisién de recopilacién
bibliografica de estudios realizados en el drea en el fundo La Cantera y el Guindo y se
complementd con identificacion de especies en terreno.
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Amenazas: La formacién del Bosque Caducifolio de Concepcion se ha visto diezmada durante
décadas por las plantaciones forestales de Pinus radiata y Eucalyptus globulus, vy, segln cifras
oficiales de la CONAF, para el afio 2017 existian 1.255.890 ha de plantaciones forestales en la
region del Biobio, de las cuales 780.112,8 ha correspondian a Pinus radiata y 424.204,4 ha a
Eucalyptus sp, en contraposicion a las escuetas 845.552,3 ha de Bosque Nativo. Sin embargo, y a
pesar de la importancia que brinda este sistema a las especies asociadas y la comunidad aledania,
estos bosques se encuentran altamente fragmentados, siendo catalogado en enero 2021 por la
Unidn Internacional por la Conservacién de la Naturaleza (UICN) como en En peligro critico de
extincion, no obstante, solo el 3,2% del Bosque Nativo regional se encuentra bajo proteccién, y en
particular la formacién vegetacional Bosque caducifolio de Concepcidn no se encuentra
representado en ningun sistema de proteccién oficial.

La exponencial vulnerabilidad de este ecosistema debido a las presiones antrdpicas producto de
incendios forestales, extraccion ilegal de madera y éridos, y la constante sustitucidn del bosque
nativo por plantaciones exdticas, aumentan la necesidad por proteger y conservar los ultimos
relictos del Bosque Caducifolio de Concepcion y de las especies que subsisten y coexisten en él,
sobre todo si consideramos que, si bien los estudios relacionados a esta drea aumentan el
conocimiento biotico de la zona, estos no reflejan del todo la riqueza que alli se encuentra,
ademas, la informacién recopilada esta fuertemente concentrada para ciertas taxas, mientras que
otras, como los briéfitos sensu stricto, ni siquiera se han evaluado, lo que intensifica la necesidad
por describir este territorio.

Asi mismo, y si bien existe un nimero no menor de especies paragua (como lo son las especies
protegidas por su categoria de conservacién) que comprometen la conservacion de la zona, se
debe considerar que alrededor de un 62% de las especies catastradas no estan evaluadas por los
organismo gubernamentales o no presentan informacion sobre su abundancia poblacional, lo que
implica un enorme vacio de informacién, dando paso a una desproteccion exponencial de la zona,
lo que abre el camino a la destruccion de este sistema, aumentando mads aun con proyectos como
la linea de alta tensién que atravesara el Parque Nacional Nonguén y supone la tala de bosque
nativo, el loteo y urbanizacién del Cerro Manquimavida en Chiguayante y Hualqui, y la creacidn de
un parque cientifico en el Cerro Caracol, que implica la inundacién de quebradas, tala de bosque
nativo y el desplazamiento de especies endémicas y En Peligro de Extincién como lo es Aegla
concepcionensis, quien sélo se distribuye en estos cerros.
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V.  Otros antecedentes relevantes para la consideracién de esta
solicitud.

28 de noviembre del 2019 - Carta de respuesta del rector Universidad de Concepcion,
don Carlos Saavedra: EL dia 11 de noviembre, 14 organizaciones socioambientales del Gran
Concepcion entregaron al director de desarrollo e innovacién de la Universidad, Claudio Maggi,
una carta abiertad que expresa la preocupacién de la comunidad frente a la amenaza que supone
para la cuenca del Cércamo la concrecién del proyecto “loteo fundo la cantera y el guinda”
medidaticamente conocido como “Parque cientifico y tecnoldgico del Biobio — PACYT”.

Con fecha 28 de noviembre el rector de la UdeC, respondid a la carta5 con una serie de
argumentos y compromisos dentro de los cuales destaca la proposicion de un acuerdo
socioambiental por la proteccién del territorio entre el parque metropolitano cerro caracol y la
reserva nacional Nonguén, denominado “paisaje de conservacion de Concepcion”. Segln el rector
Saavedra este compromiso estableceria la proteccién y restauracidn ecologica de este macro
territorio.

10 de julio del 2020 - Paisaje de conservacion del territorio Nonguén: En conformidad a los
acuerdos tomados en la sesién del “Consejo Consultivo de Administracion del Parque Nacional
Nonguén” el viernes 10 julio del 2020, se acordd la elaboracién de un informe que defina el drea
de “Paisaje de Conservacién” en torno al Parque Nacional Nonguén. En la actualidad este proyecto
se encuentra en curso, impulsado por los municipios de Concepcién, Chiguayante y Hualqui.

18 de noviembre del 2020 — Didlogos Ciudadanos en el Alto Caracol: Biocultura urbana:
Proyecto adjudicado por la junta de vecinos de la Agiiita de la Perdiz en colaboracién a académicas
de la Universidad de Concepcion, financiado con fondos del Ministerio de Ciencia, Tecnologia,
Conocimiento e Innovacién (CP200136) bajo la linea de ciencia publica, que busca promover el
dialogo entre el conocimiento comunitario y el conocimiento cientifico en torno a la biocultura del
Alto Caracol y Cerro Caracol y la importancia de este ecosistema para las comunidades que
habitan en sus faldeos.

21 de enero de 2021 - Plan maestro del PMCC: Estudio licitado por el Servicio de Vivienda v
Urbanismo (SERVIU) de Biobio y ejecutado por la consultora IDOM. El Objetivo del estudio es
contar con un Plan Maestro para el Parque Metropolitano Cerro Caracol, que permita obtener un
diagnostico de las condiciones fisicas, medioambientales y paisajisticas del Parque y una propuesta
de organizacién de espacio fisico como una herramienta de desarrollo a largo plazo para
conservar, proteger y restaurar los elementos que integran su ecosistema, a través de actividades,
equipamientos e infraestructuras que permitan un desarrollo sustentable, con la participacién de
los sectores publicos y sociales involucrados en el 4rea, en beneficio de todos los habitantes de la
Regidn del Biobio y de la intercomuna.

08 de Julio de 2021 — Recategorizacién de la reserva nacional Nonguén a Parque Nacional:

El 31 de agosto 2021, el Ministerio de Bienes Nacionales publica en el Diario Oficial la re-
categorizacion de la Reserva Nacional Nonguén a Parque Nacional y crea el “Parque Nacional
Nonguén” en la Region del Biobio. Lo anterior, segln los lineamientos establecidos por el Sistema
Nacional de Areas Silvestres Protegidas del Estado (SNASPE). Este cambio tiene como objetivo
preservar la flora y fauna de dicho recinto, a fin de resguardar su biodiversidad en el mediano y

largo plazo.

4 Carta abierta organizaciones sociales a UdeC; MPs/ity/2TMs¥z
5 Respuesta UdeC a carta abierta: https://bitly/38welGu
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VI  Estructura del material anexado

En complemento al presente informe, se anexa una serie de archivos digitales disponibles para su

L https://bit.ly/3ESJolA
consulta en el siguiente enlace:

A continuacién, se describe la estructura y contenidos generales de la carpeta anexada.

BBDD
Cartografias
Paquetes_Cartegrafices_MPK
Proyectos_Cartograficos_ MXD
(32 FICHA TECNICA HUMEDAL ESTERO CARCAMO.docx
£33 Vertices Humedal Estero Carcamo.xlsx

1. BBDD: Contiene el respaldo total de bases de datos geoespaciales utilizadas en la
confeccion de las cartografias asociadas, incluye:

e Humedal_Estero_Carcamo.gdb: Esri File Geodatabase que incluye 3 Features
Dataset y 10 Feature Class incluyendo la delimitacién del humedal y los vértices
asociados. Cabe destacar que la metadata asociada se desarrollo en base al
estandar “FGDC CSDGM METADATA”.

e SHP: Corresponde al respaldo de coberturas contenidas en la geodatabase
anterior en formato Esri Shapefile

e KML: Cartografia en formato Google Earth KMZ con el total de capas vectoriales
incluidas en la geodatabase anterior.

e RASTER: Archivos geoespaciales de tipo raster utilizados para la delimitacion del
humedal.

o Sentinel_2021_06_07.vrt: Virtual raster que incluye las 4 bandas utilizadas
para la confeccion de indices espectrales de falso color en base a imagenes
del satélite sentinel sensor 2a con fecha 07/06/2021.

o DEM_Carcamo.tif: Modelo digital de elevacion correspondiente a una
extraccion del levantamiento cartografico efectuado en 2013 por el plan
regulador metropolitano de concepcién. Cuenta con una resolucion
espacial de 5 metros

2. Cartografias: Contiene la totalidad de ca rtografias exportadas en formaro TIF

3. Proyectos_Cartograficos_MXD: Contiene la totalidad de proyectos cartograficos utilizados
para la confeccion de cartas en formato ArcMap Document MXD.

4. Paquetes_Cartograficos_MPK: Contiene la totalidad de proyectos cartograficos portables
utilizados para la confeccién de cartas en formato Esri Map Package MPK.

5. FICHA TECNICA HUMEDAL ESTERO CARCAMO.docx: Respaldo digital del informe de
solicitud para la inclusion del humedal Estero Carcamo como parte de los humedales
urbanos de la comuna de concepcién.

6. Vértices Humedal Estero Carcamo.xlsx: Planilla Excel con el total de vértices identificados
en la delimitacién del humedal Estero Carcamo.

18



Ministerio del

Medio
- Ambiente
tlv \ W ‘J! C
CIPALIDAD DE,
Goblerno de Chils CAUDAD DE LA INDEPENDENCIA

VI. REFERENCIAS BIBLIOGRAFICAS

Angulo, A. & M., Casanueva. 1981. CATALOGO DE LOS LEPIDOPTEROS GEOMETRIDOS DE CHILE
(LEPIDOPTERA: GEOMETRIDAE). Boletin de la Sociedad de Biologia de Concepcién 51: 7-39.

Angulo, A. &. T., Olivares. 2005. UN INVENTARIO GLOBAL Y BIBLIOGRAFICO DE LA SUBFAMILIA NOCTUINAE
DE CHILE (LEPIDOPTERA: NOCTUIDAE). SHILAP Revista de Lepidopterologia, 33(130): 131-166.

Angulo, A., Lemaire, C., & T., Olivares. 2004. CATALOGO CRITICO E ILUSTRADO DE LAS ESPECIES DE LA
FAMILIA SATURNIIDAE EN CHILE (LEPIDOPTERA: SATURNIIDAE). Gayana (Concepcion), 68(1), 20-42.

Araneda, C & G. Palfner. 2018. DIFERENCIAS COMPOSICIONALES DE HONGOS ENTRE DIFERENTES
CLASIFICACIONES DE MADERA EN DESCOMPOSICION. Informe Unidad de Investigacion, Facultad de
Ciencias Naturales y Oceanogréficas. Universidad de Concepcidn.

Baeza, M., C. Marticorena Y R. Rodriguez. 1997. TEXTO GUIA PARA LA IDENTIFICACION DE LA FLORA
VASCULAR DE LA PROVINCIA DE CONCEPCION. Ediciones de la Vicerrectoria Académica-Direccién de
Docencia, Universidad de Concepcién.363 pp.

Barriga-Tufidn, J. E. 2009. GUIA DE COLEOPTERA NEOTROPICALES. http://www.coleoptera-neotropical.org

Bocaz, P., & L., Parra. 2005. REVISION Y BIONOMIA DEL GENERO SYNCIRSODES BUTLER 1882 (LEPIDOPTERA:
GEOMETRIDAE). Revista Chilena de Historia Natural, 78(1), 89-111

Bocaz-Torres, P., Angulo, A. & L., Parra. 2013, DIVERSIDAD DE MACROLEPIDOPTEROS NOCTURNOS DE LA
RESERVA NACIONAL NONGUEN (Insecta: Lepidoptera). SHILAP Revista de Lepidopterologia 41 (163): 337-
347.

Camousseight, A. 2006. ESTADO DE CONOCIMIENTO DE LOS EPHEMEROPTERA DE CHILE. Gayana.
(Concepcidn), 70(1), 50-56.

Catastro de especies Coordinadora por la Defensa del Alto Caracol (2019-2021).

Chung, P. 2005. GUIA DE CAMPO. PRINCIPALES HONGOS MICORRICICOS COMESTIBLES Y NO COMESTIBLES
PRESENTES EN CHILE. Biblioteca INFOR.

Cid-Arcos, M., & C., Pineda. 2019. NEOXESTUS QUADRIMACULATUS (COLEOPTERA: EROTYLIDAE): UNA
NUEVA ESPECIE DE TRITOMINI DE CHILE CENTRAL. Rev. Chilena de Entomologia, 45(4): 689-694.

CONAF. 2019. Plan de manejo Reserva Nacional Nonguén.

Diban, M. 2019. PATRONES BIOGEOGRAFICOS DE LOS ENSAMBLES DE HONGOS AGARICALES S.L. EN
BOSQUES DOMINADQOS POR NOTHOFAGUS OBLIQUA (MIRB) QERST. Y NOTHOFAGUS MACROCARPA
(A.DC.) VASQ. & RODR. EN UN GRADIENTE LATITUDINAL. Tesis para optar al Grado de Magister en
Ciencias Bioldgicas. Universidad de Chile.

EULA. 2019. INFORME MONITOREO AMBIENTAL “FAUNA ICTICA”, CAMPANA ESTIAJE. Universidad de
Concepcidn, Chile.

Figueroa, M. 2004. FLORA Y VEGETACION DEL FUNDO LA CANTERA Y EL GUINDO. Memoria de titulo Ing.
Forestal, Universidad de Concepcidn. 84 pp.

Figueroa, R., Valdovinos, C., Araya, E., & O. Parra. 2003. MACROINVERTEBRADOS BENTONICOS COMO
INDICADORES DE CALIDAD DE AGUA DE RiOS DEL SUR DE CHILE. Rev. Chilena de Historia Natural, 76:
275-285.

Fuentes, G. 2017. POTENCIAL EVOLUTIVO EN CUATRO RELICTOS DE VEGETAACION NATIVA DE LA
CORDILLERA DE LA COSTA DE LA REGION DEL BIOBIO, CHILE. Tesis Doctoral en Ciencias Bioldgicas,
Universidad de Concepcidn, Chile.

Gajardo R. 1994. LA VEGETACION NATURAL DE CHILE. CLASIFICACION Y DISTRIBUCION GEOGRAFICA.
Editorial Universitaria, 143pp.

Gaete, D. 2016. GUIA DE RECONOQCIMIENTO PARA ARBOLES, ARBUSTOS Y TREPADORAS NATIVAS DEL
FUNDO LA CANTERA Y EL GUINDO. Memoria de titulo Ing. Forestal, Universidad de Concepcién, 34 pp.
Gamundi, |. & Amos, V. 2007. EXPLORACIONES MICOLOGICAS EN TIERRA DEL FUEGO. Boletin Soc. Argentina

Bot. 42 (1-2): 131-148.

Gonzélez P; 2004, IDENTIFICACION DE LAS AVES DEL PREDIO LA CANTERA Y EL GUINDO, TEMPORADA
INVIERNO-PRIMAVERA. Memoria de titulo Ing. Forestal, Universidad de Concepcidn. 124 pp.

Guevara, M. 2015. EFECTOS DE LA REDUCCION DEL CAUDAL POR ACTIVIDADES AGRICOLAS EN RIOS DE LA
ZONA MEDITERRANEA DE CHILE. Tesis de grado Doctor en Cs. Ambientales, Facultad de Cs. Ambientales,
Universidad de Concepcidn, Chile.

Heiss, E. 2017. THE ARADIDAE OF CHILE (HEMIPTERA: HETEROPTERA). Linzer biol. Beitr., 49: 147-158.

Jerez,V. & P., Bocaz. 2006. AULONODERA DARWINI Champiun 1918, A LEAF LITTER FLEA BEETLE FROM
NOTHOFAGUS FOREST, CHILE. Redescription and Biological Remarks (Colepotera: Chrysomelidae). The
Coleopterists Bulletin, 60 (3): 217-223.

Lazo, W. 2001. Hongos de Chile: atlas micolégico. Ed: Universidad de Chile. 316 pp.

Marin, C; Torres-Llinds, D;Furci, G; Godoy, R; & G., Palfner. 2018. ESTADO DEL ARTE DE LA CONSERVACION
DEL REINO FUNGI EN CHILE. vol7. 98-115.

19



. Ministerio del
# Medio
<HEFa<  Ambiente

MUNICIPALIDAD D,

CONCEPCION

Goblerno de Chile CIUDAD DE LA INDEPENDENCIA

Morales, A. 2016. DIAGNOSTICO Y PROPUESTA DE OBRAS CIVILES QUE MITIGUEN EL IMPACTO SOBRE LA
ICTIOFAUNA DEL ESTERO NONGUEN. Informe de proyecto de titulo para optar al titulo de Ingeniero Civil
Industrial. Facultad de Ingenieria, UCSC. Concepcidn, Chile.

Olivares, T.S., Angulo, A., & G, Moreno. 2008. DIVERSIDAD DE LOS NOCTUIDAE EN EL CORREDOR BIOLOGICO
NEVADOS DE CHILLAN-LAGUNA DEL LAJA (LEPIDOPTERA: NOCTUIDAE). Shilap Revta. Lepid., 37 (148):
389-404.

Palma, A., Figueroa, R., Ruiz, V., Araya, E. & P, Berrios. 2002. COMPOSICION DE LA DIETA DE
ONCORHYNCHUS MYKISS (WALBAUM 1792) (PISCES: SALMONIDAE) EN UN SISTEMA FLUVIAL DE BAJA
INTERVENCION ANTROPICA: ESTERO NONGUEN, VIII REGION, CHILE. Gayana 66 (2): 129-139.

Parra, L., & C., Herndndez. 2010. ESTUDIO FILOGENETICO DE LOS GENEROS DE LITHININI EN SUDAMERICA
AUSTRAL (LEPIDOPTERA, GEOMETRIDAE): UNA NUEVA CLASIFICACION. Rev. Bras. Entomol. 54 (1).

Parra, L., & M., Pascual-Toca. 2003. REVISION TAXONOMICA DE LOS GENEROS ORATA WALKER 1863 Y
HASODIMA BUTLER 1882 (LEPIDOPTERA: GEOMETRIDAE). Revista Chilena de Historia Natural, 76: 117-
128.

Parra, L., Angulo, A. & C., Jana-Saenz. 1986. LEPIDOPTEROS DE IMPORTANCIA AGRICOLA: CLAVE PRACTICA
PARA SU RECONOCIMIENTO EN CHILE (LEPIDOPTERA: NOCTUIDAE). Gayana Zool., 50(1-4): 81-116.

Parra, L., Jaque, E., Zamora-Manzur, C., & M,, Ramos-Gonzalez. 2019. LOS LEPIDOPTEROS GEOMETRIDAE DE
LA CORDILLERA DE LA COSTA, CHILE. Biodiversidad y Ecologia de los Bosques Costeros de Chile. Editorial
Universidad de Los Lagos, pp. 61-67.

Pisano, E. 1996. MACROMYCETES DE BOSQUES DE NOTHOFAGUS BETULOIDES. Proyecto Rio Céndor.

Ramos-Gonzélez, M., Zamora-Manzur, C., Rose-Garrido, C., & L. Parra. 2018. AN UPDATED CATALOGUE OF
THE GEOMETRIDAE (LEPIDOPTERA: GEOMETROIDEA) FROM CHILE. PART |1 ARCHIEARINAE,
GEOMETRINAE AND STERRHINAE. Gayana (Concepcion), 82(1), 15-25.

Ravenna, P; S. Teiller; J. Macaya; R. Rodriguez & O. Zdliner. 1998. CATEGORIAS DE CONSERVACION DE LAS
PLANTAS BULBOSAS NATIVAS DE CHILE. Boletin del Museo de Historia Natural vol. 47, 47-68 pp

Retamal, C. 2020. VARIABILIDAD MOREOLOGICA DE LA ARMADURA GENITAL DEL MACHO EN DOS ESPECIES
DE LA TRIBU TRICHOPTERYGINI (LEPIDOPTERA: GEOMETRIDAE). Seminario de Titulo Bidlogo. Universidad
de Concepcidn. Chile

Rodriguez, R., C. Marticorena, D. Alarcdn, C. Baeza, L. Cavieres, V.L. Finot, N. Fuentes, A. Kiessling, M. Mihoc,
A. Pauchard, E. Ruiz, P. Sanchez & A. Marticorena. 2018. CATALOGO DE LAS PLANTAS VASCULARES DE
CHILE. Gayana Botanica 75(1): 1-430.

Romano, G., Greslebin, A. & Lechner, B. 2017. HONGOS AGARICOIDES DE LOS BOSQUES DE NOTHOFAGUS
PUMILIO (CHUBUT, ARGENTINA): CLAVE Y LISTADO DE ESPECIES. Revista Museo Argentino Ciencias
Naturales 19: 39-69.

Salazar, V. & Diban, M. 2019. HONGOS COMESTIBLES Y TOXICOS DEL PARQUE NACIONAL NONGUEN.
PROYECTO: CONTRIBUCION AL CONOCIMIENTO DE LOS MACROHONGOS PRESENTES EN EL PARQUE
NACIONAL NONGUEN (CONAF).

Salazar, V. & Diban, M. 2019. HONGOS LLAMATIVOS DEL PARQUE NACIONAL NONGUEN. PROYECTO:
CONTRIBUCION AL CONOCIMIENTO DE LOS MACROHONGOS PRESENTES EN EL PARQUE NACIONAL
NONGUEN (CONAF).

Salazar, V. & Troncoso, S. 2015. PRIMER REGISTRO DE UN HONGO HIPOGEO EN LA RESERVA NACIONAL
NONGUEN. Setas y Plantas Micdfilos.

Salgado, J. 2006. NUEVAS APORTACIONES AL CONOCIMIENTO DE CAMIARINAE Y CHOLEVINAE
(COLEOPTERA: LEIODIDAE) NEOTROPICALES Y DESCRIPCION DE UNA NUEVA ESPECIE DE CHILE. Boletin
del Museo Nacional de Historia Natural, 55: 87-111.

Salgado, J. 2006. NUEVAS APORTACIONES AL CONOCIMIENTO DE CAMIARINAE Y CHOLEVINAE
(COLEOPTERA: LEIODIDAE) NEOTROPICALES Y DESCRIPCION DE UNA NUEVA ESPECIE DE CHILE. Boletin
MNHN, Chile, 55:87-111.

Sepulveda-Sanchez & Skewes, 2015. MESOMAMIFEROS EN LA RESERVA NACIONAL NONGUEN:
Antecedentes de una reserva reciente y cercana a una gran ciudad, Concepcién, Chile.

Sganga, J. 2005. EL GENERO SMICRIDEA McLACHLAN (TRICHOPTERA: HYDROPSYCHIDAE: SMICRIDEINAE) EN
EL URUGUAY. Universidad de Buenos Aires, Argentina.

Silva, M. 2014. TAXONOMIA Y FACTORES ECOLOGICOS QUE AFECTAN A ACAROS MESOSTIGMATA
ASOCIADOS A ROEDORES DEL NORTE DE CHILE. Tesis de grado Magister en Cs. Mencién Zoologia,
Universidad de Concepcidn, Chile.

Skelley, P. 2001. XALPIRTA, N. GEN., AND NEOXESTUS CROTCH (1876) FROM -CHILE AND SOUTH AMERICA
(COLEOPTERA: EROTYLIDAE: TRITOMINAE). Insecta Mundi, 15 (4): 221-241.

Smith-Ramirez, C; Teillier, S; Jiménez, J, Barahona-Segovia, R; Parra, L; Vera, A; & V., Jerez. 2019. ENDEMIC
PLANTS AND ANIMALS OF THE CHILEAN COASTAL RANGE. Biodiversidad y Conservacion de los Bosques
Costeros de Chile (pp.393-416), Universidad de Los Lagos, Chile.

Soto, J., Olivares, L. & Barra, P. 2010. DETERMINACION DE ZONA DE INFLUENCIA ECOLOGICA DE LA FUTURA

20



Ministerio del
Medio
> Ambiente

MUNCIPALDADDE,

CONGEPCION

Goblerma de/Chika CIUDAD DE LA INDEPENDENCIA

RESERVA NACIONAL NONGUEN. CONAF Concepcidn, 110 pp.

Troncoso, F., & A. Bustamante. 2013. APROXIMACION AL ESTUDIO DE LAS ARANAS DE LA RESERVA
NACIONAL NONGUEN. Fondo de apoyo a la investigacién patrimonial, DIBAM, Chile.

Valenzuela, E. & Esteve-Raventos, F. 1999. ALGUNOS AGARICALES S.L. ALOCTONOS ASOCIADOS A ESPECIES
ARBOREAS EXOTICAS CULTIVADAS EN LA X REGION DE CHILE. Boletin Micoldgico 14 (1-2): 73-81.

Valenzuela, E., Moreno, G., Garnica, S. & Ramirez, C. 1998. MICOSOCIOLOGIA EN BOSQUES NATIVOS DE
NOTHOFAGUS Y PLANTACIONES DE PINUS RADIATA EN LA X REGION DE CHILE: DIVERSIDAD Y ROL
ECOLOGICO. Revista Chilena de Historia Natural 71: 133-146.

Valenzuela, E.; Moreno, G. & Polette, M. 1996. AGARICALES SENSU LATO TOXICOS RECOLECTADOS EN LA X
REGION DE CHILE. Boletin Micoldgico 11 (1-2): 1-10.

PAGINAS WEB

Ministerio del Medio Ambiente. Consultado por tltima vez 28 Julio 2021. Enlace; "*"-™™€°b<

Reglamento para la Clasificacién de Especies Silvestres segin Estado de Conservacién. Versién 16° proceso
(2021). Consultado por dltima vez 25 de Julio 2021. Enlace; “*""-<sfficacionespecies.mma.god.cl

Unién Internacional para la Conservacion de la Naturaleza. Consultado por Ultima vez 3 de noviembre 2021.
Enlace: www.iucn.org/es

21



A Ministerio del
}ﬂﬂ Medio
.J'm >

F4 Ambiente

Goblerna de Chile

MUNICIPALIDAD ﬁE .
CONCEPCION
CIUDAD DE LA INDEPENDENCIA

ANEXO 1. CATASTRO DE FLORA DEL HUMEDAL ESTERO CARCAMO.

| Nombre cientifico Familia 0 E°Consv. Fuentee® Fuente sp.'
Acacia rr;elanoxyl_pn R. Br Fabaceae I NE MMA Figueroa, 2004
Acaena argentea Ruiz & Pav. Rosaceae N NE MMA CONAF,2019 -

~ Acaena ovalifolia Ruiz & Pav. Rosaceae N NE MMA  Figueroa, 2004 |

" Acrisione denticulata Hook. & Asteraceae N NE MMA  Figueroa, 2004

Arn ) [—
Adiantum chilense Kaulf Adiantaceae I'N NE MMA Figuerba, 2004
Aextoxicon punctatum Ruiz & Aextoxicaceae | E LC UICN . Figueroa, 2004

| Agrostis inconspicua Kunze ex Poaceae N NE MMA Fuentes, 2017

E. Desv.

| Alonsoa meridionalis (L.fil.)  Scrophulariaceae N NE MMA Figueroa, 2004

: Kuntze YA | i i i e A s
Amomyrtus luma (Molina) D. Myrtaceae N LC UICN CONAF,2019

~ Legrand & Kausel e

~ Arachnitis uniflora Phil. Corsiaceae N NE MMA  COORDAC

| Aristotelia chilensis (Molina) Elaeocarpaceae N NE MMA | Figueroa, 2004
Stuntz ‘

| Asplenium dareoides Desv. Aspleniaceae N LC MMA CONAF,2019

Asplenium trilobum Cav. Aspleniaceae N vu MMA CONAF,2019

Azara dentata Ruiz & Pav. Salicaceae E NE MMA  Figueroa, 2004
Azara integrifolia Ruiz & Pav. Salicaceae E NE MMA Figueroa, 2004
Azara serrata Ruiz & Pav. Salicaceae E NE MMA  Figueroa, 2004

. Baccharis obovata Hook. & Asteraceae N NE MMA Fuentes, 2017

. Baccharis racemosa Ruiz & Asteraceae N NE MMA 5 Figueroa, 2004
Pav. ke e e ot e e i

- Baccharis rhomboidalis J. Rémy Asteraceae N NE MMA Fuentes, 2017
Baccharis salicifolia (Ruiz & Asteraceae N NE MMA Fuentes, 2017

| Pav.) Pers. |
Berberis negeriana Tischler Berberidaceae E . EN-Rara MMA COORDAC
Blechnum chilense (Kaulf.) Blechnaceae N LC MMA Figueroa, 2004
Mett.
Blechnum hastatum Kaulf. Blechnaceae N LC MMA  Figueroa, 2004

. Blechnum magellanicum Blechnaceae N S - CONAF,2019
(Desv.) Mett. L |
Blepharocalyx  cruckshanksii Myrtaceae E NT UICN Figueroa, 2004
(Hook. & Arn.) Nied. . E U
Bomarea salsilla (L.) Mirb. Alstroemeriaceae N NE MMA Figueroa, 2004

| Boquila trifolio.'ata(QC:!____Decne Lardizabalaceae N NE MMA ~ Figueroa, 2004

| Buddleja globosa Hope ' Scrophulariaceae N LC UICN Figueroa, 2004
Calceolaria dentata Ruiz & Pav. Calceolariaceae N S. - Figueroa, 2004
Calceolaria integrifolia  (L.) Calceolariaceae N S - Figueroa, 2004
Ruiz & Pav. |
Caldcluvia paniculata (Cav) D. Cunoniaceae N LE UICN Figueroa, 2004

' Don

| Calydorea xiphioides (Poepp.) Iridaceae E vu RCE Figueroa, 2004
Espinosa |

- Carex acutata Boott Cyperaceae E S. MMA Fuentes, 2017
Carex aphylla Kunth Cyperaceae E S. MMA Figueroa, 2004

| Carex bracteosa (Rchb.) Kunze Cyperaceae N S.l MMA Fuentes, 2017
ex Kunth
Carex chilensis Brongn. ex Cyperaceae N S. MMA | COORDAC

. Duperrey -
Carex erinacea Cav. Cyperaceae E S - COORDAC
Carex excelsa Poepp. ex Kunth Cyperaceae N S. - COORDAC
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Carex fuscula D'Urv
Carex multispicata Kunze ex
Kunth
Carex phalaro:des Kunth
L ' Carex phleoides Cav.
| Carex quinquin Jim. Mejias &
Dorr

Cent:peda elatinoides (Less.) :

| Befntrh & Hook. f. ex O. Hoffm

Ch:ropeta-'um tncuspidatum
(tam) A Juss.
Chusquea quila Kunth

Cirsium arvense (L.) Scop.

Cissus striata Ruiz & Pav.
Citronella mucronata (Ruiz &
Pav.) D. Don

Clinopodium multiflorum (Ruiz
& Pav.) Kuntze

Conanthera bifolia Ruiz & Pav.

Conyza sumatrensis (Retz.) E.
Walker

Cryptocarya alba (Molina)
Looser

. Cyperus eragrostis Lam.

~ Cytisus striatus Rothm.

Dasyphyllum
(Less.) Cabrera
_ Daucus carota L.

Delmrea oa'orata Lem

Deyeuxia
(Poir.) Kunth var. |
_ viridiflavescens

Dichondra sericea Sw.
 Dioscorea auriculata Poepp.
" Dioscorea bridgesii Griseb. ex
. Kunth

. Dioscorea humilis Bertero ex
 Colla subsp. humilis

| Drimys winteri J. R. Forst. & G.
Forst var winteri

Escallonia pulverulenta Ruiz &

Eleocharis sp. R. Br.
_ Epilobium sp. L.

Eryngium pamculatum Cav. &
Dombey ex F. Delaroche
Erythranthe glabrata (Kunth)
G. L. Nesom
Escallonia myrtoidea Bertero
ex DC.

Pav.
E}.:calyptus globulus Labill.

Eucryphia cordifolia Cav.

. Eupatorium glechonophyllum

. Less.

- Francoa append:culata Cav.

 Fuchsia magellanica Lam.

. Galium hypocarpium (L.) Endl.

ex Griseb.

diacanthoides :

viridiflavescens

Cyperaceae
Cyperaceae

Cyperaceae
Cyperaceae
Cyperaceae

Asteraceae
Euphorbiaceae

Poaceae
Asteraceae
Vitaceae
Icacinaceae

Lamiaceae

Tecophilaeaceae
Asteraceae

Coriariaceae
Lauraceae

Cyperaceae
Fabaceae
Asteraceae

Apiaceae
Asteraceae
Poaceae

Convolvulaceae

Dioscoreaceae
Dioscoreaceae

Dioscoreaceae
Winteraceae
Cyperaceae
Onagraceae
Apiaceae

Phrymaceae

Escalloniaceae

Escalloniaceae

Myrtaceae
Cunoniaceae
Asteraceae

Francoaceae
Onagraceae
Rubiaceae

m =z —m

=2 ' m

S.
S

S
S
S

S

S

S.
S
S
EN

NT

S.
S

S.
S

S.
LC
LC

S
Sl
S

S.
S.
S.

S.

LC

S.

51

S.
H
S.
S|

S.
NT
5

5.l
LC
s.l
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MMA
MMA

MMA

MMA

MMA
RCE

RCE

MMA
MMA

MMA

UICN

LU

MMA

UICN

: .MMA .

MMA

MMA

MMA
UICN
MMA

UICN
MMA

! Fuentes 20 17

COORDAC
COORDAC

COORDAC
COORDAC
COORDAC

' COORDAC

Figuerba, 2004
Fuentes, 2017

' COORDAC

" COORDAC

Figueroa, 2004
Figueroa, 2004

Fuentes, 2017

Figueroa, 2004
Fuentes, 2017

CONAF,2019
Figueroa, 2004

_Figueroa, 2004

Fuentes, 2017
CONAF,2019

Figueroa, 2004
Fuentes, 2017

Fuentes 2017

Figueroa, 2004
Figueroa, 2004

““Fuenteé, ”27017

' Figueroa, 2004

Figueroa, 2004

COORDAC

- COORDAC

COORDAC

' Figueroa, 2004

- 'mFigUeroa, 2004_ E
- Figueroa, 2004
- COORDAC

FlguerQa 2004

' Figueroa, 2004

i Figueroa, 2004
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Gastridium phleoides (Nees &
Meyen) C.E. Hubb.

| Gaultheria insana (Molina) D.J.

Middleton

| Gaultheria phillyreifolia (Pers.)
| Sleumer

Genista monspessulana (L.) L.
| A.S. Johnson

| Geranium core-core Steud.
Gevuina avellana Molina

' Gnaphalium sp.

fGreig:'a sphacelata "(Ruiz &
| Pav.) Regel

Gunnera
| Mirb.

tinctoria  (Molina)

Herrériq-}tellatd Ruiz & Pav.

Hymenophyllum peltatum

(Poir.) Desv.

Hymenophyllum plicatum
| Kaulf.

. Hypericum perforatum L.

Hypolepis poeppigii (Kunze)
RARodr. |
Isolepis nigricans Kunth
Jovellana violacea (Cav.) G.
Don.

Juncus sp. L.

Kageneckia oblonga Ruiz &

Pav.

Lé};;geria r&s_gankuiz & Pav.

Lardizabala biternata Ruiz &

Pav.

Lathyrus magellanicus Lam.
Laurelia sempervirens (Ruiz &
Pav.) Tul.

Laureliopsism phﬂ'ifpbiana -
- (Looser) Schodde
. Lepechinia chamaedryoides

' (Balb.) Epling
| Lepechinia chilensis (Molina) R.

' Morales

Libertia sessiliflora (Poepp.)
. Skottsb.

 Lithrea caustica (Molina) Hook.
& Am.

 Lobelia tupa L. B
' Lomatia dentata (Ruiz & Pav.)

R.Br. ‘ B
Lomatia hirsuta (Lam.) Diels
Luma apiculata (DC.) Burret

Luma chequen (Molina) A.E

Gray

Luzuriagzz radicans Ruiz & Pav.

Madia sativa Molina

Maytenus"boaria Molina
Muehlenbeckia hastulata (Sm.)
I.M. Johnst.

Mutisia spinosa Ruiz & Pav.
Myoschilos oblongum Ruiz &

Poaceae
Ericaceae
Ericaceae
Fabaceae

Geraniaceae
Proteaceae
Asteraceae

Bromeliaceae

Gunneraceae

Asparagaceae
Hymenophyllaceae

Hymenophyllaceae

Hypericaceae
Dennstaedtiaceae

Cyperaceae
Calceolariaceae

Juncaceae
Rosaceae

Philesiaceae
Lardizabalaceae

~ Fabaceae
Atherospermatace
ae
Atherospermatace
ae
Lamiaceae

Lamiaceae
Iridaceae
Anacardiaceae

Campanulaceae
Proteaceae

Proteaceae
Myrtaceae
Myrtaceae

Luzuriagaceae
Asteraceae
Celastraceae
Polygonaceae

Asteraceae
Santalaceae

mzZ 22

m Z

Z2 2 2 Z

=2

S

S.

S.|

S.|
S

vu

LC

S

LC

S
NE

S|
S|

LC

S.

S
NT

LC

S.

S.

S.

LC

S.
LC

LC
LC
LC

S.
LC
S.

S.
S.
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MMA

MMA

MM

MMA

UICN

UICN

MMA
RCE

MMA
MMA

UICN
UICN
MMA
UICN

UICN

UICN

UICN
UICN

UICN

- Fuentes, 2017
- Figueroa, 2004
Figueroa, 2004

Fuéntes, 2017

Figueroa, 2004 -

~ Figueroa, 2004
COORDAC

Figueroa, 2004 |

Fuentes, 2017
Fuentes, 2017

Figueroa, 2004

' CONAF,2019

| COORDAC |

Figueroa, 20"04

COORDAC

~ COORDAC

' Figueroa, 2004

| COORDAC

;_ F_i_gueroa, 2004

i Figueroa, 2004

 Figueroa, 2004

f Fuenteé, 2017
' COORDAC

Figueroa, 2004

Figueroa, 2004

| Figueroa, 2004
Figueroa, 2004

Figueroa, 2004

UICN

JuieN

MMA

Figueroa, 2004

Figueroa, 2004
_F_'8Ue rq ?‘ 2004 ........
Figueroa, 2004

COORDAC

Figuerroar,goql}m |
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Pav.)

Myrceugenia exsucca (DC.) O.
Berg

' Myrceugenia obtusa (DC.) O.
| Berg

‘Myrceugema parvifolia (DC.)
Kausel

Myrceugenia pinifolia (F. Phil.)
Kausel

Nertera granadensis (Mutis ex

- Lf.) Druce

Nothofagus dombeyi (Mirb.)

| Qerst.
' Nothofagus obliqgua (Mirb.)
| Oerst.
Ochagawa carnea (Beer) L.B.
Sm. & Looser
 Oxalis rosea Jaca.
' Pasithea caerulea (Ruiz & Pav.)
D. Don
Persea lingue (Ruiz & Pav.)
Nees
Peumus boldus Molina
Pinus radiata D. Don ‘
Pitavia punctata (sz & Pav.)
Molina
Plantago major L.
Plantago truncata Cham. &
Schitdl.

Pleopeltis macrocarpa (Bory ex
Willd.) Kaulf.

Podanthus ovatrfohus Lag
Podocarpus saligna D. Don
Polypogon interruptus Kunth
_Pc_)pulus alba L.

Proustia pyrifolia DC.

Puya sp Molina

Quercus robur L.

lela;a saponaria Molina
' Rhamnus diffusus Clos

Rhaphithamnus

(Juss.) Moldenke

spinosus

Ribes punctatum Ruiz & Pav.
Rosa rubiginosa L.

| Rubus ulmifolius Schott
ﬁﬁr';;é;zgnglo-m-emtus Murray
'Salpiglossis sinuata Ruiz & Pav.
Schinus  polygamus  (Cav.)
_Cabrera

| Senecio aquattcus Hill subsp.

| barbareifolius  (Wimm. &
Grab.) Walters
jo sylvaticus L.

Sttpuiacea (Alton) H.S.
Irwin & Barneby
Sisyrinchium chilense Hook.
 subsp. chilense
| Sisyrinchium

graminifolium

Myrtaceae
Myrtaceae
Myrtaceae
Myrtaceae
Rubiaceae
Nothofagaceae
Nothofagaceae
Bromeliaceae

Oxahdaceae
Asphodelaceae

Lauraceae

Monimiaceae
Pinaceae
Rutaceae

Plantaginaceae
Plantaginaceae

Polypodiaceae

Asteraceae

Podocarpaceae

Poaceae
Salicaceae
Asteraceae
Larﬁiaceae
Bromeliaceae
Fagaceae
Quillajaceae
Rhamnaceae
Verbenaceae

Grossulariaceae
Rosaceae
Rosaceae

Polygonaceae
Solanaceae
Anacardiaceae

Asteraceae
Asteraceae
Fabaceae
Iridaceae

Iridaceae

Z mm — m— m — ZzZ mm

Z2\Z .7 T &2

LC

Sl

Vu

LC

oH

LC

LC

S

S.I
S.

NT

[c
S
EN

S.
S.

Sl

S.|
S:
S.
S

LC
LC
5.
S.I

Sl
Sl
S.
S.
NE
NE

LC

S

NE

NE

NE

Wik .., L U:v ALJHE Vi

CI]NIIEPCIGN

DAD DE LA INDEPENDENCIA

UICN  Figueroa, 2004
5 Figueroa, 2004
UICN CONAF,2019
UICN CONAF,2019
- Figueroa, 2004
UICN CONAF,2019
UICN Figueroa, 2004

= Fuentes, 2017

- Flgueroa 2004

- ' COORDAC
UICN Figueroa, 2004

UICN  Figueroa, 2004
- Figueroa, 2004
RCE | COORDAC

- Fuentes, 2017
- Fuentes, 2017

UICN  CONAF,2019
MMA ' F'igueroﬂé,ﬂﬁi
- CONAF,2019
- Figueroa, 2004
MMA  Fuentes, 2017
- ~ Figueroa, 2004
o . Figueroa, 2004
= | Figueroa, 2004
UICN Fuentes, 2017
UICN CONAF,2019
- Figueroa, 2004 _

- MMA - Figueroa, 2004

"MMA  Figueroa, 2004
MMA Figueroa, 2004
- . Figueroa, 2004
MMA Figueroa, 2004
MMA  Figueroa, 2004
Fphilippi  COORDAC

UICN  Figueroa, 2004

— Flientes, 2017
MMA  Figueroa, 2004

MNHN Figueroa, 2004
MNHN Figue'rég, 2004
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Lindl.
Sisyrinchium striatum Sm.
Solanum crispum Ruiz & Pav.
Solanum furcatum Dunal
Solenomelus
(Gillies ex Hook.) Hochr.

Sophora macrocarpa Sm.
Stachys grandidentata Lindl.

Synammia feuillei (Bertero) |

Copel.
‘ Teucrium bicolor Sm.
Tristerix verticillatus (Ruiz &
. Pav.) Barlow & Wiens
Tropaeolum sp.
- Ugni molinae Turcz.
| Ulex europaeus L.
Verbena bonariensis L.
3 Veronica serpyllifolia L.
 Vicia nigricans Hook. & Arn.
 Viola capillaris Pers.

Siglas:

pedunculatus :

Iridaceae
Solanaceae
Solanaceae

Iridaceae

Fabaceae
Lamiaceae
Polypodiaceae

Lamiaceae
Loranthaceae

Tropaeolaceae
Myrtaceae
Fabaceae
Verbenaceae
Plantaginaceae
Fabaceae
Violaceae

O (Origen)= Introducido (1), Nativo (N), Endémico (E)
E° Consv. (Estado de conservacién) = No Evaluado (NE), Preocupacion menos (LC), Casi amenazada (NT), Vulnerable
(VU), En Peligro (EN), En Peligro Critico (CR).

mz Z2 2

m

NE
NE
NE
NE

S
LC
NE

NE
S

S
LC
S.|
LC
LC
S.I

MUNCIPALIDAD DE,

CONCEPCION
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MMA  Figueroa, 2004
MMA  Figueroa, 2004 |
MMA Figueroa, 2004
MMA  COORDAC
MMA  Figueroa, 2004
MMA  Figueroa, 2004
MMA COORDAC
MMA Figueroa, 2004
- ' Fuentes, 2017
""" Figueroa, 2004
MMA Figueroa, 2004
UICN  Fuentes, 2017
MMA Figueroa, 2004
UICN | Fuentes, 2017
UICN  Figueroa, 2004

_ Figueroa, 2004
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ANEXO 2. CATASTRO DE HONGOS HUMEDAL ESTERO CARCAMO.

Ea

No c:ent:f:co Familia o

” Consv. i

| Agaricus xanthodermus Genev. Agaricaceae I S. - . COORDAC

| Amanita diemii Singer Amanitaceae N S. - 3 Diban, 2019
?Amanita gayana (Mont.) Sacc. Amanitaceae E NT RCE - COORDAC
Amanita gemmata var. toxica Lazo Amanitaceae E S. - | Salazar & Diban,
; 2019

. Amanita muscaria (L.) Lam. Amanitaceae | NE IUCN | Salazar & Diban,

o “ | 2019
| Anthracophyllum discolor (Mont.) Marasmiaceae N LC ' RCE Dibén, 2019
. Singer |
1 Austropaxillus boletinoides (Singer) Serpulaceae N 5:l - COORDAC

Bresinsky & Jarosch t s ]

Balsamia vulgaris Vittad. Helvellaceae | S.l - Salazar & |
;ﬁﬁﬂ . Troncoso, 2015
' anporel!a citrina (Batsch) Korf & Helotiaceae I S.| - | Salazar & Diban,
....... LS E.Carp. 2019a

Bjerkandera adusta (willd.) P. Phanerochaetaceae | S. - Araneda &

Karfsgi . Palfner, 2018
‘  Bolbitius pluteo:desM M. Moser Bolbitiaceae I S - Araneda &

........................ ‘ Palfner 2018 |

' Boletus loyita E. Horak Boletaceae vu RCE COORDAC

Baletus loyo Phrlllppl Boletaceae EN RCE Salazar & D:ban
I . 2019
| Ca!ocera wscosa(Pers ) Fr. Dacrymycetaceae I 5.l - COORDAC

Chalaporus piperatus (Bull.) Boletaceae I S.I - COORDAC

| Bataille
i qugqna zollingeri Lév Clavariaceae [ LC IUCN Diban, 2019 |

Clavulinopsis amoena (Zoll. & Clavariaceae | S. - ! lean, 2019 '
| Moritzi) Corner |
| Clitocybe pleurotus Singer Tricholomataceae N S.l - " Araneda 9
__________ L= | | Palfner, 2018
~ Clitocybula dusenii (Bres.) Singer Tricholomataceae N LC RCE Diban, 2019
Collybiasp. - - - -  Diban, 2019
. Coprinellus disseminatus (Pers.) J.E. Psathyrellaceae | S.l - ‘ Dibén, 2019
Lange
Cortinarius  aff. austroduracinus Cortinariaceae N S. -  Diban, 2019
~ Moser f
. Cortinarius austrolimonius Moser & Cortinariaceae N S. - Diban, 2019
' Horak -

Cortinarius chlorophanus M. M. Cortinariaceae N S. - . Dibén, 2019
 Moser
' Cortinarius lebre Garrido Cortinariacea E vu RCE Diban, 2019 !
| Cortinarius magellanicus Spegazzini Cortinariacea N LE RCE | Dibén, 2019

Cortinarius viscovenetus E. Horak Cortinariaceae E S. - : Diban, 2015

Crepidotus aff. app!anatus (Pers.) P. Crepidotaceae | S. - Dibén, 2019

Kumm 4 e i M R e
WCréprdotus brunswickianus (Speg.) Crepidotaceae N Sl " Araneda & |

Sacc.  Palfner, 2018

Creprdotus eprbryus(Fr)QueI Crepidotaceae I Sl - - Diban, 2019

Crepidotus mollis (Schaeff.) Staude Crepidotaceae | S. - Diban, 2019 |

Cystangium ;5 Russulaceae - - - Diban, 2019
_ Descolea antarctica Singer Cortinariacea N LC RCE CMMA
' Descolea pallida E. Horak Bolbitiaceae N LC  RCE ' Dibén, 2019
* Entoloma aff. cucurbita E. Horak Entolomataceae N S. - Diban, 2019
i Entolomataceae N VU RCE Salazar & Diban,

Entoloma necopinatum E. Horak
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Entoloma  nubigenum  (Singer)
Garrido

| Entoloma  pseudonothofagi  E.
Horak & Garrido

| Galerina patagonica Singer
| Galiella coffeata Gamundi

Ganoderma australe (Fr.) Pat.

| Gastroboletus valdivianus E. Horak
| Guepiniopsis alpina (Earle) Brasf.

Gymnopﬁus junonius (Fr) P.D. Orton

. Gymnopilds sapineus (Fr.) Murrill
. Gymnopus aquosus (Bull.) Antonin
- & Noordel

' Gymnopus subpruinosus (Murrill)

Desjardin, Halling & Hemmes
Gyromitra antarctica Rehm
Hohenbuehelia phalligera (Mont.)
Singer

Hydropus lipocystis Singer

Hygrocybe coccinea s.l. (Schaeff.) P.

| Kumm.
| Hymenogaster sp.

Hypholoma fasciculare (Huds.) P.
Kumm.

~ Inocybe erythrobasis Singer
~ Inocybe fuscata Singer

Inocybe geophyllomorpha Singer

. Inocybe neuquenensis (Singer)
| Inocybe subfibrosoides Singer
| Lactarius deliciosus (L.) Gray

Lycoperdon perlatum Pers.

Macrolepiota rhacodes (Vittad.)

Singer

EMarasmieMus alliiodorus (Mont.)
| Singer

Marasmius nothom yrciae Singer
Mycena atroincrustata Singer

Mycena chusqueophila Singer

- Mycena cyanocephala Singer

5 Kumm.

Mycena filopes (Bull.} P. Kumm.

Mycena haematopus (Pers.) P.

. Mycena pura (Pers.) P. Kumm.
' Mycena subulifera Singer

Mycena tenerrima (Berk.) Quél

. Mycenella sp.

Entolomataceae
Entolomataceae

Hymenogastraceae
Sarcosomataceae

Ganodermataceae

Boletaceae
Dacrymycetaceae

Hymenogastraceae

Hymenogastraceae
Omphalotaceae

Omphalotaceae

Discinaceae
Pleurotaceae

Mycenaceae
Hygrophoraceae

Strophariaceae

Inocybaceae
Inocybaceae
Inocybaceae
Inocybaceae
Inocybaceae
Russulaceae
Russulaceae
Polyporaceae

Agaricaceae
Lycoperdaceae

Agaricaceae
Omphalotaceae

Marasmiaceae
Mycenaceae

Mycenaceae
Mycenaceae
Mycenacéée
Mycenaceae
Mycenaceae

Mycenaceae
Mycenaceae
Mycenaceae

- T T 22222

=2

- — — = m

S.

S

S.
S

S.

EN
S.

S.I

S
S|

S.

S
S.

S
S|

Sl

S
S.I
S
S
S.
S.
S.
S.

S.
LC

S

NE

S.
sl

S.
NE
S.
Sl
S|

S.
NT
Sl

' RCE

Diban, 2019

Diban, 2019

Dibdn, 2019
~ Araneda

 Palfner, 2018

~ Araneda

7 ‘

&

Palfner, 2018 |

MMA

Salazar & Diban,wé

2019

IUCN

' Dibén, 2019
Diban, 2019

' Diban, 2019

COORDAC

COORDAC

' Dibén, 2019

' Diban, 2019

Araneda
Palfner, 2018

Diban, 2019

- Diban, 2019
 Dibén, 2019
 COORDAC

Arahédé

' Diban, 2019
| Salazar & Diban,

| 2019

COORDAC

~ Diban, 2019

e 5518

Araneda
Palfner, 2018
Dibén, 2019

Dibén, 2019

' COORDAC

0
Palfner, 2018 |

| Diban, 2019

Diban, 2015

Dibén, 2019

" Dibén, 2019

Dibén, 2019

| Dibén, 2019
| Diban, 2019
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Neoclitocybe microspora Singer

‘Notho;afnea thaxteri (E.K. Cash)
| Gamundi

' Orbilia xanthost.rgma (Fr.) Fr

Pholiota sp.
Pholiotina aff. austrofilaris Singer

| Plectania chilensis (Mont.)
| Gamundi .
| Pleurotus ostreatus (Jacq.) P.
Kumm.

Pluteus brunneoolivaceus E. Horak

' Pluteus jaffuelii (Speg.) Singer
Pluteus spegazzinianus Singer

| Pluteus sub}narginatus E. Horak

_Polyporus melanopus (Pers.) Fr.

- Porpoloma sejunctum Singer

' Psathyrella sp.

' Ramaria botrytis (Pérs.) Bourdot

Ramaria flaccida ‘var. chilensis
(Lazo)

Ramaria flava (Sciﬁéff.) Quél.

| Rhizopogon luteolus Fr.

_Rhizopogon roseolus (Corda) Th. Fr.
Rimbachia arachnoidea var bispora
(Singer) Blanco-Dios

' Russula fuegiana Singer

Russula sardonia Fr.

Schizophyllum commune Fr.
' Scutellinia sp.

Sowerbyella rhenana (Fuckel) ).
. Moravec
_ Stereum hirsutum (Willd.) Pers

Stereum rameale (Pers ) Burt
Sun'!us luteus (L.) Roussel

| Terana caerulea (Lam.) Kuntze

3Telfrtx',oyrgos alba (Eerk. & M.A.
' Curtis) E. Horak

Trametes hirsuta (Wulfen) Lloyd

 Trametes versicolor (L.) Lioyd
| Tremella sp.

Tricholoma fusipes E. Horak
_ Tubaria sp.

Tricholomataceae
Pyronemataceae
Orbiliaceae
Strophariaceae
Bolbitiaceae
Sarcosomataceae
Pleurotaceae

Pluteaceae

Pluteaceae
Pluteaceae

Pluteaceae

Polyporaceae
Tricholomataceae
Psathyrellaceae
Gomphaceae

Clavariaceae
Gomphaceae
Rhizopogonaceae
Rhizopogonaceae

Tricholomataceae

Russulaceae
Russulaceae

Schizophyllaceae
Pyronemataceae
Pyronemataceae

Stereaceae
Stereaceae

Stereaceae
Suillaceae

Phanerochaetaceae
Marasmiaceae
Po-lyporaceae
Polyporaceae
Tremellaceae

Tricholomataceae
Tubariaceae

S.1

vu

Sl

S

S

S.

LG
S:l

Sl

S.
LE

5:1

S.

5.

S.1
S.
S

LC
5.l

S.

S.

S.
S.

S.|
S.

S.

S

S.

5:l

S

IUCN

MUNICIPALIDAD D,

CONCEPCION

-v‘.\ n

CRUDAD OF LA INDEPENDENCIA

Araneda & |

Palfner, 2018
COORDAC

Araneda &
Palfner, 2018
Dibéan, 2019
Diban, 2019
. Araneda &
 Palfner, 2018

Palfner, 2018
Araneda &

Diban, 2019

' Araneda & 3

~ Palfner, 2018

Araneda & |

Palfner, 2018

Araneda &

Palfner, 2018
' COORDAC
Dibén, 2019
Diban, 2019

Salazar & Dibén,

2019

Diban, 2019

Salazar & Diban,
2019
' COORDAC
COORDAC
Dibén, 2019

Diban, 2019
Salazar & Diban,
2019

- Salazar & Dibén,
| 2019a :
| Araneda &

Palfner, 2018

Salazar & Diban,

2019a
D__q___ban 2019
Palfner, 2018
Diban, 2019

Salazar & Diban,
£ 2019

Salazar & Dibén,
2019a
Diban, 2019

‘Araned“a. a &

Araneda &

Araneda & 5

Palfner, 2018

; Salazar & lean
: 2019&

Diban, 2019
lean, 2019
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Xylaria arbuscula Sacc. Xylariaceae I s - ~ Araneda &
’ ' Palfner, 2018 |
Xylaria castorea Berk. Xylariaceae I S. - ‘ Araneda &

' Palfner, 2018

Siglas:

O (Origen)= Introducido (1), Nativo (N), Endémico (E)

E° Consv. (Estado de conservacion) = No Evaluado (NE), Preocupacion menos (LC), Casi amenazada (NT), Vulnerable
(VU), En Peligro (EN), En Peligro Critico (CR)
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ANEXO 3. CATASTRO DE FAUNA HUMEDAL ESTERO CARCAMO.

Nombre cientifico

Abrothrix longipilis Waterhouse
Abrothrix olivaceus Waterhouse

Acanthinodera cumingii Hope
Accipiter  chilensis  Philippi &
. Landbeck

Adetomeris erytrops Blanchard

Aegla concepcionensis Schmitt
~ Agriornis livida Kittlitz
Agrotis hispidula Guenée

Agrotis malefida Guenée
Agrotis subterranea Fabricius

Agyrtodes ovatus Portevin
Akymnopellis chilensis Gervais

. Anairetes parulus parulus Klittitz
Antarctoperla michaelseni Klapalek
Anthus correndera Lesson
Aphrastura spinicauda spinicauda
Gmelin
Aulonodera darwini Champion

- Austrotinodes sp

| Batrachyla leptosus Bell
Batrachyla taeniata Girard
Belostoma sp.
Birabenella sp.

Bubo virginianus nacurutu Vieillot
"""" Buteo polyosoma Quoy & Gaimard
Calacadia sp.

Callipepla californica Shaw
' Callipielus arenosus Butler

Callipielus izquierdoi Ureta
Callipielus perforata Nielsen &

Robinson
Callipielus salasi Robinson

' Calyptocephalella gayi Duméril &
Bibron
Caprimulgus longirostris Gould
Carduelis barbatus Molina
Carventus chilensis Kormilev

! Cercophana frauenfeldii Felder

Chilesia sp.

Familia

Cricetidae
Cricetidae
Cerambycidae
Accipitridae

Saturniidae

Aeglidae
Tyrannidae
Noctuidae

Noctuidae
Noctuidae

Leiodidae
Scolopendridae
Tyrannidae
Gripopterygidae
Motacillidae
Furnariidae

Chrisomelidae
Ecnomiidae
Batrachylidae
Batrachylidae
Belostomatidae
Oonopidae

Strigidae
Accipitridae
Accipitridae

Amphinectidae

Odontophoridae
Hepialidae

Hepialidae
Hepialidae
Hepialidae
Caprimulgidae
Fringillidae
Aradidae
Geometridae

Saturniidae

Arctiidae

zzz =

Z222=2"'" m 2 2 2 22 " e

2 2 2

2 m 2

En
Consv.
LC
LC

LC
vu

NE

EN
LC
S.

S.

S.l

S
S.
LC
S
LC
LC

LC
NT

S.
LC
LC

LC
NE

S.

S

S

LC

LC

CH

S.l

S.

Fuente
EU

UCN

UICN
MMA
MMA

MMA

MMA
UICN

UICN

UICN
UICN

MMA
MMA

UICN
UICN

UICN
MMA

UICN

UICN

MMA

MMA

Fuente sp.

CONAF, 2016" i
CONAF, 2019
COORDAC
Gonzélez, 2004
Bocaz-Torres et.al,
2013
COORDAC
CONAF, 2019
Bocaz-Torres
2013
Bocaz-Torres
2013
Bocaz-Torres
2013

Salgado, 2006
COORDAC
Gonzalez, 2004
CONAF, 2019
CONAF, 2019
Gonzalez, 2004

et.al,
et.al,

et.al,

Jerez & Bocaz. 2006
CONAF, 2019
CONAF, 2019
CONAF, 2019
CONAF, 2019
Troncoso &
Bustamante, 2013
Gonzélez, 2004
CONAF, 2019
Gonzalez, 2004
Troncoso &
Bustamante, 2013
Gonzélez, 2004
Bocaz-Torres
2013
Bocaz-Torres
2013
Bocaz-Torres
2013
Bocaz-Torres
2013

Gonzalez, 2004

et.al,
et.al,
et.al,

et.al,

Gonzalez, 2004
Heiss, 2017
Bocaz-Torres
2013
Bocaz-Torres
2013
Bocaz-Torres

et.al,
et.al,

et.al,
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Chiliopelates nigrus Jeannel
Chloroclydon rinodaria Felder &
Rogenhofer

Cinclodes patagonicus Gmelin
Cistothorus platensis Lesson
Coironalia denticulata Mayordomo

Colaptes pitius Molina
Colorhamphus parvirostris Darwin
Columba araucana Lesson
Columbina picui picui Temminck
Conepatus chinga Molina
Coragyps atratus Bechstein
Curaeus curaeus Molina

Dagostina  fasciata  Orfila &
Schajovskoy
Dalaca cuadricornis Nielsen &
Robinson

Dargida albilinea Hiibner

Dasypelates gracilis Portevin
Dectochilus antucaria Felder &
Rogenhofer

Dipoena sp.

Diuca diuca Molina
Dromiciops gliriodes Thomas
Dubiaranea sp.

Elaenia albiceps D'Orbingny &
Lafresnaye
Ennada  pellicata  Felder &
Rogenhofer

Eosericostoma inaequispina Schmid
Eriopyga perfusca Hampson

Euathlus manicata Simon
Euclidiodes meridionalis Wallengren

Eugralla paradoxa Kittlitz
Euophrys patagonica Simon

Euophrys sp.
Euophrys tehuelche Galiano

Eupelates transversestrigosus
Fairmaire & Germain

Eupsophus roseus Duméril & Bibron
Falco sparverius Swainson

Galictis cuja Molina

Gamakia hirsuta Ramirez

Gambusia affinis Baird & Girard
Gayenna americana Nicolet

Glaucidium nanum King

Leiodidae
Geometridae

Furnariidae
Troglodytidae
Geometridae

Picidae
Tyrannidae
Columbidae
Columbidae
Mephitidae
Cathartidae
Emberizidae
Geometridae

Hepialidae
Noctuidae

Leiodidae
Geometridae

Theridiidae

Thraupidae

Microbiotheridae

Lyniphiidae
Tyrannidae
Geometridae

Helicophidae
Noctuidae

Theraphosidae
Geometridae

Rhinocryptidae
Salticidae

Salticidae
Salticidae
Leiodidae

Alsodidae
Falconidae
Mustelidae
Anyphaenidae

Poeciliidae
Anyphaenidae

Strigidae
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S.

5il
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LC
NT
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S.|

S
S|

NT
S.

LC
Sl

Si

S

Vu
LC
LC
S

LC
S|

LC

MMA

UICN
UICN

UICN
UICN
UICN
UICN
CAZA
UICN
UICN

MMA

UICN
RCE

UICN

MMA

UICN

RCE
UICN
MMA

UICN

UICN

L"]

MUNCPALIDADOE,

CONCEPCION

fVCQ DE LA INDEPENDENCIA
2013

Salgado, 2006
Bocaz-Torres mét.al,
2013

Gonzalez, 2004
CONAF, 2019
Bocaz-Torres et.al,
2013

Gonzalez, 2004
Gonzalez, 2004
Gonzalez, 2004
CONAF, 2019
CONAF, 2019
Gonzdlez, 2004
Gonzélez, 2004
Bocaz-Torres et.al, |
2013 _
Bocaz-Torres et.al,
2013

Bocaz-Torres et.al,
2013

Lazo, 2001
Bocaz-Torres et.al,
2013

Troncoso &
Bustamante, 2013
CONAF, 2019

CONAF, 2019
Troncoso &

Bustamante, 2013
Gonzalez, 2004

Bocaz-Torres et.al,
2013

CONAF, 2019
Bocaz-Torres et.al,
2013

CONAF, 2019
Bocaz-Torres et.al,
2013

CONAF, 2019
Troncoso &
Bustamante, 2013
Troncoso &
Bustamante, 2013
Troncoso &

Bustamante, 2013
Salgado, 2006

CONAF, 2019
CONAF, 2019
CONAF, 2019
Troncoso &
Bustamante, 2013
Morales, 2016
Troncoso &
Bustamante, 2013
Gonzalez, 2004
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Gnolus sp.

Gundlachia gayana
Hasodima bartletti Parra & Pascual

Hasodima boreas Mayordomo
. Hemieuxoa conchidia Butler

Histiotus macrotus Poeppig
Histiotus montanus Philippi &
Landbeck

Hoplosauris schausi Warren

Hyalélla sp.
Incalvertia valdiviana Rindge

Inequivalva photophila Mayordomo

Lagynopteryx botulata Felder &
Rogenhofer

Lasiurus borealis Miiller

Lasiurus  cinereus  Palisot de
| Beauvois

- Leopardus guigna Molina

Leptasthenura aegithaloides Kittlitz
Leucauge sp.

Lirﬁnaperla jaffueli Navas

| Liolnemus cyanogaster Duméril y
Bibron

Liolaemus lemniscatus Gravenhorst
Liolaemus pictus Duméril y Bibron
Liolaemus tenuis Duméril y Bibron

| Lycalopex culpaeus Molina

| Macrolyrcea monochorda Prout
Macromphalia felis pardalis Felder
Malenella sp.

' Massartellopsis sp

Mastigoptyla brevicornuta Flint

Megalographa bonaerensis Berg

Meridialaris sp.
Meriola barrosi Mello-Leitdo

: Meriola manuel Platnick & Ewing
Meriola sp.

Microclysia pristopera Prout
Milvago chimango Vieillot

Mimus thenca Molina
Minanapis sp.

Mimetidae

Ancylidae
Geometridae

Geometridae
Noctuidae

Vespertilionidae
Vespertilionidae

Geometridae

Hyalellidae
Geometridae

Noctuidae
Geometridae

Vespertilionidae
Vespertilionidae

Felidae

Furnariidae
Tetragnathidae

Gripopterygidae
Liolaemidae

Liolaemidae
Liolaemidae
Liolaemidae
Canidae

Geometridae
Lasiocampidae
Anyphaenidae
Leptophlebiidae
Glossosomatidae

Noctuidae

Leptophlebiidae
Corinnidae

Corinnidae
Corinnidae
Geometridae
Falconidae

Mimidae
Anapidae
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Ui m,A
Troncoso &
Bustamante, 2013
CONAF, 2019
Bocaz-Torres et.al,
2013

Bocaz-Torres et.al,
2013
Bocaz-Torres
2013
CONAF, 2019
CONAF, 2019

et.al,

Bocaz-Torres et.al,
2013

CONAF, 2019
Bocaz-Torres et.al,
2013

Bocaz-Torres et.al,
2013

Bocaz-Torres et.al,
2013

CONAF, 2019
CONAF, 2019

Sepulveda-Sanchez
& Skewes, 2015
Gonzélez, 2004
Troncoso &
Bustamante, 2013
CONAF, 2019
CONAF, 2019

CONAF, 2019
CONAF, 2019
CONAF, 2019
Sepulveda-Sanchez
& Skewes, 2015
Bocaz-Torres et.al,
2013

Bocaz-Torres et.al,
2013

Troncoso &
Bustamante, 2013
CONAF, 2019
CONAF, 2019
Bocaz-Torres et.al,
2013

CONAF, 2019
Troncoso &
Bustamante, 2013
Troncoso &
Bustamante, 2013
Troncoso &
Bustamante, 2013
Bocaz-Torres et.al,
2013

Gonzélez, 2004
CONAF, 2019
Troncoso &
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Myocastor coypus Molina
Myotis chiloensis Waterhouse
Nebula diana Mayordomo

Neorumia gigantea Bartlett-Calvert
Neorumia lutea Bartlett-Calvert

Neoxestus Skelley &
Cekalovic

Notholoba schausi Warren
Nothoprocta perdicaria Kittlitz
Notoperlopsis sp

Nousia sp

Nycticorax nycticorax Bonaparte

Oarces reticulatus Nicolet

nonguen

Odontothera virescens Butler

Oligoryzomys longicaudatus
Bennett

Opisogonia diffisata  Felder &
Rogenhofer

Ormiscodes socialis Feisthamel
Parapielus reedi Ureta
Pecanapis sp.

Peridroma clerica Mayordomo
Peridroma saucia Hiibner
Perusia aurantiacaria Blanchard
Perusia gracilis Bartlett-Calvert

Philodryas chamissonis Wiegmann
Phrygilus patagonicus Lowe

| Phyllotis darwini Waterhouse

' Phytotoma rara Molina

Picoides lignarius Molina
Plectroboarmia sp.

Pleurodema thaul Lesson
Polythysana cinerascens Philippi

Pristidactylus torquatus Philippi
Proteopharmacis valdiviata Warren

Pseudaletia punctulata Blanchard
Pseudoleucania diana Butler

Pseudoleucania luteomaculata

| Angulo & Olivares
Psilaspilates ceres Mayordomo

Myocastoridae
Vespertilionidae
Geometridae
Geometridae
Geometridae

Erotylidae

Geometridae
Tinamidae
Gripopterygidae
Leptophlebiidae
Ardeidae
Mimetidae

Geometridae
Cricetidae
Geometridae
Saturniidae
Hepialidae
Anapidae
Noctuidae
Noctuidae
Geometridae
Geometridae
Fringillidae
Cricetidae
Dipsadidae
Phytotomidae
Picidae
Geometridae

Leiuperidae
Saturniidae

Leiosauridae
Geometridae

Noctuidae
Noctuidae
Noctuidae

Geometridae
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Bustamante, 2013
CONAF, 2019
CONAF, 2019
Bocaz-Torres
2013
Bocaz-Torres
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Pteroptochos castaneus Philippi & Rhinocryptidae

Landbeck

Pteroptochos tarnii King

Pudu pudu Molina

Pygarrhichas albogularis King
Rallus sanguinolentus Hellamyr

Rhinoderma darwinii
Bibron

Scelorchilus rubecula Kittlitz
Scytalopus magellanicus Gmelin
Sephanoides galeritus Molina

Sheranapis sp.

Sicales luteiventris Meyen

Simulium sp.
| Smicridea sp.

Sofanapis cf. Antillanca Platnick &

Forster

Stephanopis ditissima Nicolet

Strix rufipes King
Sturnella loyca Molina

Sylviorthorhynchus desmursii Gay
Syncirsodes primata Walker

Syngrdbha gammoides Blanchard

Synneuria sp.

Tachycineta meyemi Meyen
Tachymenis chilensis Schlegel
Tadarida brasiliensis Geoffroy

Tegenaria sp.

Tipula sp.
Tomopisthes sp.

Trichovespula macrocera Schmid
Triptiloides laeta Philippi

Troglodytes aedon Vieillot

. Turdus falcklandii King

Tyto alba tuidara J.E. Grey
Vanellus chilensis chilensis Molina

Xolmis pyrope Kittlitz
' Zale lunata Drury

Zenaida auriculata auriculata Des

Murs
Zonotrichia
Meyen

Siglas:

O (Origen)= Introducido (1), Nativo (N), Endémico (E), Cosmopolita { C)

capensis

Rhinocryptidae
Cervidae

Furnariidae
Rallidae

Rhinodermatidae

Rhinocryptidae
Rhinocryptidae
Trochilidae
Anapidae

Emberizidae
Simuliidae

Hydropsychidae

Anapidae
Thomisidae

Strigidae
Emberizidae
Furnariidae
Geometridae

Noctuidae
Geometridae

Hirundinidae
Dipsadidae
Molossidae
Agelenidae

Tipulidae
Anyphaenidae

Tasimiidae
Geometridae

Troglodytidae
Muscicapidae
Tytonidae
Charadriidae
Tyrannidae
Noctuidae

Columbidae

Emberizidae
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Gonzalez, 2004

Gonzidlez, 2004
Sepulveda-Sanchez
& Skewes, 2015
CONAF, 2019
Gonzélez, 2004
CONAF, 2019

Gonzélez, 2004
CONAF, 2019
Gonzalez, 2004
Troncoso &
Bustamante, 2013
Gonzalez, 2004
CONAF, 2019
CONAF, 2019

Troncoso &
Bustamante, 2013
Troncoso &

Bustamante, 2013
CONAF, 2019
Gonzélez, 2004
Gonzalez, 2004
Bocaz-Torres et.al,
2013

Bocaz-Torres et.al,
2013

Bocaz-Torres  et.al,
2013

Gonzélez, 2004
CONAF, 2019
CONAF, 2019
Troncoso &
Bustamante, 2013
CONAF, 2019
Troncoso &
Bustamante, 2013
CONAF, 2019
Bocaz-Torres et.al,
2013

Gonzalez, 2004
Gonzélez, 2004
Gonzalez, 2004
Gonzalez, 2004
Gonzalez, 2004
Bocaz-Torres et.al,
2013

Gonzélez, 2004

Gonzélez, 2004

E° Consv. (Estado de conservacién) = No Evaluado (NE), Preocupacién menos (LC), Casi amenazada (NT), Vulnerable

(VU), En Peligro (EN), En Peligro Critico (CR)

35



